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Recommended additional reading

● Tekla online services landing page http://www.tekla.com/services
● Trimble Identity for online services

https://teklastructures.support.tekla.com/not-version-specific/en/trimble_identity_faq
● Tekla Structures Installation Guide

https://teklastructures.support.tekla.com/2021/en/ins_about_tekla_structures_installation
● Tekla Structures licensing system

https://teklastructures.support.tekla.com/2021/en/fle_flexnet_licensing_system
● Tekla Structures Hardware recommendations 2021

https://teklastructures.support.tekla.com/2021/en/ins_tekla_structures_hardware_recommendations
● Administrator’s Release Notes 2021

https://teklastructures.support.tekla.com/2021/en/admin_guide_tekla_structures_administrators_guide
● Centralized distribution of Tekla Structures

https://teklastructures.support.tekla.com/support-articles/centralized-distribution-tekla-structures-2021s

1. Introduction
This guide describes how to take Tekla Structures into use and how to customize it to meet the needs of your
company and projects.

Tekla provides documentation on how Tekla Structures works and how it can be customized, see Tekla Structures
Product Guides and Support Articles from TUA https://teklastructures.support.tekla.com/

1.1 Trimble Identity
You need a Trimble Identity to download Tekla Structures and to use your online licenses. The Trimble Identity is
connected to a Tekla Online organization (a user group for your physical organization). Tekla Online services use
Trimble Identity for identification. In addition to Tekla services, you can use your Trimble Identity with several
other Trimble services, such as Trimble Connect and SketchUp 3D Warehouse.

Trimble Identity provides single-sign-on access for Tekla Online services. You can sign in one service and then
browse to another online service without a need to log in again. Find the services landing page here:
http://www.tekla.com/services

Creating a Trimble Identity on your first license purchase

● If you did not have an existing Trimble Identity, Trimble sends you an email with an invitation to complete
your account creation. Create your account using the link in the email and make sure you fill in all of the
required user profile information.

● If you are a company's named contact, you are invited to your Tekla Online organization by Trimble when
the organization is created in Tekla Online.

● You will receive an email to accept membership in your new Tekla Online organization. You are then
responsible for managing the organization together with other administrators that you may assign. See
Managing Trimble Identities and Tekla Model Sharing licenses for more information.
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Creating a Trimble Identity to join an existing organization

● If you have received an email invitation from Trimble to create a Trimble Identity, follow the instructions in
the email to create your account to ensure you have the correct access rights. Otherwise, Click here to
create a new Trimble Identity.

● Complete the Create new account form and click the Create new account button. If you have several
different email addresses, use your company email address.

● Look for a verification email in your inbox and click the link provided to verify your account. You must
verify your account to access your Trimble Identity.

● Log in with your new account, fill in all the required user profile information, and click Save.
● If you didn’t receive an invitation email to join your Tekla Online organization, you can do it in one of the

following ways:
○ Switch to the Organization page on your user profile page, select an organization that you would

like to join, and click Send request. If there are no organizations listed, it means your email
address does not match with any existing organization's email address.

○ Ask your company's Trimble Identity administrator to invite you, and accept the invitation when it
arrives via email or on your user profile pages at https://account.tekla.com/.

● Your Trimble Identity is now active, and you can install and license Tekla Structures.

Note: If you cannot find the email in your inbox, check your Spam / Junk email folder. See the
troubleshooting information for more help in case there are problems.

Note: Membership in an organization can also affect your access to your organization's cloud-stored
data, such as Tekla Model Sharing models. Make sure you do not switch between organizations
unnecessarily. When available, use your company email address with your Trimble Identity.

Managing the Trimble Identities to join an existing organization

Tekla Online administrators manage the access of the organization's users to Tekla Online services and licenses.
One or more people in your organization can be administrators. The first user is invited to your organization group
by a Trimble representative and given administrator rights and that person is then responsible for adding other
users and administrators as necessary.

As an administrator, you are responsible for:

● Inviting employees to your organization group to allow them access to the following services:
○ Tekla Online licenses, which are licenses connected to a Trimble Identity login.
○ Tekla services and features that use Tekla Online licenses include Tekla Model Sharing, Tekla EPM,

Trimble Connect, Tekla Structures Partner configuration, and Tekla Structures elearning courses.
● Tekla discussion forum
● Part of the content in Tekla User Assistance and Tekla Warehouse
● Removing people from your organization group when they no longer belong to your organization

See Managing Trimble Identities and Tekla Model Sharing licenses for more information.
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1.2 Online Licensing
Tekla Structures cannot be used without a valid license. An online license is connected to your Trimble Identity.
The license is delivered directly to the Tekla Online Admin tool, where you as the company's Tekla Online account
administrator can assign the online licenses to individual users. When Tekla Structures starts, the end users log
into Trimble's cloud to reserve the licenses.

Tekla Structures 2021 has online licensing available for the following configurations:

● Diamond
● Graphite
● Carbon
● Educational (Tekla Campus) - You get this license by registering at campus.tekla.com. Note that you are

not allowed to use this configuration for commercial work.
● Partner - Your employer joins the Tekla Partners Program at developer.tekla.com. Once approved, your

administrator can assign a license to you in the Tekla Online Admin Tool.
● EPM Modeler - This configuration is only available with Tekla PowerFab.

See more at TUA

Note, if you have on-premises or on-demand licenses for earlier Tekla Structures versions, you need
to install a license server on your computer or on a separate server in your internal network. Tekla
Structures connects to your local license server to check your license. See more in TUA.

1.3 Tekla Structures User Assistance
Tekla Structures includes complete documentation in an accessible system. The online Tekla Structures Product
Guides and Support Articles is a detailed guide to Tekla Structures concepts, tools, commands, and features, with
plenty of examples. Use the F1 key in Tekla Structures to access. If you have a dialog box open, Tekla Structures
takes you straight to the related topic. The help is also available when Tekla Structures is not running. Go to
Windows Start Screen > All apps > Tekla Structures > Tekla User Assistance (TUA). These all are referred to
hereafter as Start Menu.

Tekla User Assistance (TUA) is a support platform for all our customers. Support material, product guides, videos
and extension help-guides can be easily found at https://teklastructures.support.tekla.com/. It is also accessible
offline inside the Tekla Structures File menu on the left side of the screen. Go to Help > User Assistance.

We strongly recommend that you use the online help when possible as it is updated constantly.

Note that when you have found something useful in the online help, you can add a topic to your
favorites or to your bookmarks depending on the browser you have used.

The README pdf in Windows Start Menu > Tekla Structures 2021 is a one page document containing very useful
information and links to Tekla products online services. The README comes in 11 languages.
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1.4 Tekla Developer Center
Tekla Developer Center is the hub for all Tekla Open API information. Visit the service at

https://developer.tekla.com/ for API reference, programming guides, exercises, code examples, community for

asking questions and sharing best practices and more.

Join Tekla Partners Program by filling out the application in Tekla Developer Center. Tekla Partners Program is

designed to help our partners and customers develop complementary applications and integrations that add value

to Tekla Structures. Read more about the Tekla Partners Program here:

https://developer.tekla.com/Tekla-Partners-Program.

1.5 Release Notes & Administrator’s Release Notes
Release Notes and Administrator’s Release Notes are released for each new version of Tekla Structures in TUA.
They contain very useful information when upgrading to a newer version of Tekla Structures. Release Notes
contains all the information about changes, new features and fixed features.

Administrator’s Release Notes is a separate section that contains useful information on how to localize the new
features. Please see TUA:
https://teklastructures.support.tekla.com/2020/en/admin_guide_tekla_structures_administrators_guide

2. Tekla Structures Installation
There are 2 main ways to install Tekla Structures on a workstation; download from the Tekla Downloads
https://download.tekla.com and run the installer to your PC, or centralized installation through MSI installation -
instructions in TUA.

2.1 Installation requirements
Operating system

The installation requires that the operating system of the target computer is 64-bit Windows 10 or 8.1.

If the operating system is different, the installation is cancelled. The installation also requires that Microsoft .NET
Framework 4.7.2 or newer is installed on the target computer. Installation of .NET Framework 4.7.2 is included in
the Tekla Structures installation package and executed if needed. Tekla Structures also needs the following
redistributable packages that are automatically installed during the Tekla Structures software installation if they,
or newer versions of the packages, do not exist on your computer:

● Microsoft Visual C++ 2010 Redistributable (x64) 10.0.40219
● Microsoft Visual C++ 2010 Redistributable (x86) 10.0.40219
● Microsoft Visual C++ 2013 Redistributable (x64) 12.0.40649
● Microsoft Visual C++ 2013 Redistributable (x86) 12.0.40649
● Microsoft Visual C++ 2015 Redistributable (x64) 14.0.23026
● Microsoft Visual C++ 2015 Redistributable (x86) 14.0.23026
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Note: If your organization installs Tekla Structures centrally using .msi packages, it may be necessary
to download the required .NET Framework and Microsoft Visual C++ Redistributable components
from Microsoft’s web site and install them separately.

Hardware recommendations

To ensure a good experience using our software, make sure your computer meets hardware recommendations,
see Tekla Structures 2021 Hardware recommendations document at TUA:
https://teklastructures.support.tekla.com/2020/en/ins_tekla_structures_hardware_recommendations

You can install Tekla Structures graphics hardware test from Tekla Warehouse to test the DirectX graphics
performance of your setup and compare it to statistics from other users.

Backup

Like all valuable information and work your company is storing, it is also important to take backups of the model
folders, firm and project settings. If your company has a system for taking automatic scheduled backups, schedule
your system to take the backups at night time, outside working hours to prevent any possible conflicts in the
model.

Virus protection

Virus protection software has sometimes caused problems with saving models and drawings to the model folder.
These problems may occur especially if you have your model saved on a network drive. We strongly recommend
you add Tekla Structures into the “safe list” of your antivirus system, and to set up your virus protection in a way
that actions in your model folder are not blocked or scanned.

2.2 Installing Tekla Structures
When installing Tekla Structures we recommend you go to the Tekla Downloads and download the latest Service
Pack (SP) of Tekla Structures. The SP is a full installation; with the full SP installer, end users can install directly the
latest Tekla Structures SP without having the final TS version installed in the first place. Besides that, the full SP
can minimize the errors occurred during the add/remove program process. Service Pack includes fixes to errors
found in the latest Final version or previous versions. The SPs can also contain new functionality. SPs are available
for all users with a valid maintenance contract.

The System Restore point will be created upon the installation process. Therefore, you can roll back
the machine to the previous state if there are any issues during or after the installation. For restore,
go to Windows Control Panel > All Control Panel Items > Recovery > Open System Restore. Select the
previous version of Tekla Structures from the list and restore it.

Tekla Structures installation must be done with administrative privileges. When installation is done in
a centralized way to the client computers, end users do not necessarily need administrator rights.
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If you do not install any environment, only the Blank environment is available. Do not use the Blank
environment to edit models or drawings; it is only a starting point meant as a basis for building your
own full customized environment and does not contain all of the tools and configurations you need
to work efficiently.

For more detailed information on installing Tekla Structures 2021, see the Tekla Structures Installation Wizard in
Tekla Downloads https://download.tekla.com

2.3    Centralized installation of Tekla Structures
Installing Tekla Structures software and environments one by one on each user’s computer might be a time
consuming task in large companies. Therefore, Tekla Structures is often installed in a centralized manner across
company workstations by using MSI packages.

Detailed information on how centralized installation of Tekla Structures is carried out in practice can be found in
TUA

2.4 Installing TSEP packages
Tekla Structures .tsep extensions (Tekla Structures extension package) are Tekla Structures extensions or
environment content installers. They are delivered in Tekla Warehouse https://warehouse.tekla.com and in Tekla
Structures environment installers. To learn more about TSEP, browse to Tekla Developer Center:
https://developer.tekla.com/documentation/tekla-structures-extension-package. The comprehensive “Creating
Tekla Structures extension packages” guide explains everything about TSEP.

There are 4 main ways to install a TSEP installer as follows:

● Environment installation
○ Tekla Structures environment installers are .msi installers. They include sets of TSEP installers that

contain the actual environment files and settings. When installing a new version of Tekla
Structures, install the software first and then the environments. Running the environment
installers does not require administrator rights.

○ When you run the environment .msi installer, the installer creates the environment folder and
copies the TSEP installers to the ..\Tekla Structures\<version>\Extensions\To be installed folder.
The installer also creates the RemoveEnv.bat and ToBeRemoved.txt files, and places them to the
..\Environments\<environment> folder. These files are used when uninstalling an environment.

○ When running the environment .msi installer, you can select in the installation wizard that the
TSEP installers are run immediately when running the environment installer. If you do not select to
do this, the TSEP installers are run when you open Tekla Structures for the first time after the
installation. In this case, Tekla Structures opens a dialog box that shows the installation progress
of the TSEP installers.

Note, if you are installing several environments for the first time, we recommend that you do not
select to run the .tsep installers immediately when running the environment installer. Some of the
.tsep packages are used in more than one environment and the same version of a .tsep package is
only installed once. Note also that starting Tekla Structures for the first time after installation can
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take a long time particularly if you have installed several environments, as all the TSEP installers are
run.

● Direct Installation
○ By default .tsep package will be opened with TepFileManager, you just need to double click the

TSEP installer you want to install. Some TSEP installers are run directly from Tekla Warehouse with
“Insert into model” option.

○ Tekla Structures Extension Manager window will show up with the extension name that is going
to be installed

○ Select the Tekla Structures versions you want to import and click the Import button. The next time
you start Tekla Structures, this extension will be automatically installed and shown in TS extension
manager.

Note: If the TSEP file is not set to open with TepFileManager by default, you can set it manually by
right clicking on the TSEP file. Then select the Tekla Structures version(s) you want to install it to.

● Tekla Structures extension manager Installation
○ You can also install a TSEP installer from Tekla Structures Extension Manager inside Tekla

Structures.

○ Click button from Applications & Components Panel. TS Extension Manager will show up.
○ Click Import... and browse to the TSEP installer you want to install.
○ Click Open. The next time you start TS, this extension will be shown in TS Extension Manager and

ready to be used.

● TSEP Centralized distribution - install
○ This approach is preferable for system administrators who require to install a batch of extensions

or environments across company workstations.
○ In order to have a TSEP extension to be installed in Tekla Structures, you need to copy the TSEP

installers to %XSDATADIR%\Extensions\To be installed folder. The default location is
\ProgramData\Tekla Structures\[TS_Version]\Extensions\To be installed\.

○ You can create the "To be installed" folder if it does not exist.
○ When Tekla Structures starts, it will check available TSEP installers from the \To be installed

folder and install automatically.
■ The Installed TSEP installers are stored in %XSDATADIR%\Extensions\Installed
■ The Invalid TSEP installers are uninstalled and moved to

%XSDATADIR%\Extensions\Invalid installations
■ The cancelled TSEP installers are stored in %XSDATADIR%\Extensions\Cancelled

installations (this includes those TSEP installers that have same or earlier version as
already installed TSEP installer)

○ We recommend using ROBOCOPY from the Command line (cmd.exe) to copy TSEP installers.
More information of ROBOCOPY can be found in https://en.wikipedia.org/wiki/Robocopy and
https://technet.microsoft.com/en-us/library/ee851678.aspx

■ The basic syntax is: robocopy <Source> <Destination> [<File>[ ...]]
[<Options>]
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■ For example: robocopy
"\\Server1\prod\TeklaStructures\2021\Environments_TSEP"
"C:\ProgramData\Trimble\Tekla Structures\2021\Extensions\To be
installed" *.tsep

■ This command will take all TSEP files from the Server1 network directory and copy to the
local user TS_INSTALLDIR.

■ robocopy "\\Server1\prod\TeklaStructures\2021\Environments_TSEP"
"C:\ProgramData\Trimble\Tekla Structures\2021.0\Extensions\To be
installed" *.tsep
"C:\Program Files\Tekla
Structures\2021.0\\nt\bin\TeklaExtensionPackage.TepAutoInstaller.exe
" 2021.0 "C:\ProgramData\Trimble\Tekla Structures\2021.0" "2021"
exit /B 0

■ This command will take all TSEP files from the Server1 network directory and copy to the
local user TS_INSTALLDIR. It also installs all .tsep files before opening Tekla Structures.

TSEP Centralized distribution - uninstall

○ You can uninstall TSEP-packages in batch by creating an empty file without extension named
"RemoveExtensionOnStartup" in \ProgramData\Trimble\Tekla
Structures\[TS_Version]\Extensions\Installed\[Extension_To_Be_Uninstalled]

○ Next time Tekla Structures starts up, it will remove these extensions.

Upgrading

If you already have an older version of Tekla Structures installed on the computer, you can use the Migration
Wizard to copy the TSEP installers and your personal settings to the new version. With the Migration Wizard you
can choose to copy any of the following settings and values:

● user.ini file
● Registry values, such as:

○ Toolbars
○ Dialog boxes
○ General options

When you customize Tekla Structures (that is, add or change drawing or report templates, catalog entries, etc.),
we recommend that you create project and firm folders for customized files. This is a useful technique if you want
to store the files for future use, or want to retain them when you install a new release.

Tekla Structures does not replace files in the project and firm folders when you install a new release, so you retain
your customized files without having to copy and paste, or export and import from previous versions.

If you have not set up project and firm folders yet, this is a good time to do so as it makes upgrading faster and
easier. If you have customized previous versions without using firm or project folders, you will need to transfer the
customized information to Tekla Structures 2021. We strongly recommend that you now use firm or project
folders. Working through the following questions will help you transfer all the information you need.

Always test that the old company settings work before taking a new version of Tekla Structures into use.
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You can also run the Migration Wizard later by running the MigrationWizard.exe that is by default
located in C:\Program Files\Tekla
Structures\2021\nt\bin\applications\tekla\Migrations\

2.5 Tekla Model Sharing
If your company is taking part in external projects or has internally more than one user working in the same
model, you are recommended to use Tekla Model Sharing. With this, your users can work in the same shared
model, offline and with high performance and synchronize the changes with other team members even in a low
speed network. Tekla Model Sharing requires additional subscription. Admins can view and manage company
shared models with Management Console https://manage.teklamodelsharing.com/.

Tekla Model Sharing enables efficient global collaborative modeling within a shared Tekla Structures model. Tekla
Model Sharing gives users the freedom to work with the same model at the same time in different locations and
time zones. Tekla Model Sharing requires a valid Tekla Model Sharing license and a Trimble Identity which is part
of a valid organization. Based on the Trimble Identity information, the organization administrator can assign and
manage Tekla Model Sharing licenses in the web-based Tekla Online Admin Tool.

In Tekla Model Sharing each user has a local version of the model on their computer or on a network drive, and
the model data is shared and synchronized over the Internet using a Microsoft Azure cloud sharing service. When
a model is shared, it is connected to the cloud-based sharing service. You can check the status of the service at
any time.

Admins can view and manage all company shared models with a web-based Management Console. Login to
Management Console at https://manage.teklamodelsharing.com/ requires admin rights on Tekla Account.

Tekla Model Sharing cloud sharing service status is publicly available at https://status.teklamodelsharing.com/. On
this web-site also, you can also find information about any service breaks.

If your company is interested in getting on-premises sharing service, you can now find comprehensive technical
installation and management guide in TUA:
https://teklastructures.support.tekla.com/not-version-specific/en/ms_installing_on_premises_sharing_service
For more information about the additional costs and IT administration need involved, please contact your local
sales.

Tekla Model Sharing requires a single-user model.

A model cannot be simultaneously shared and used in multi-user mode. If you want to start using
multi-user mode as a means to share your model instead of Tekla Model Sharing, you need to first
exclude your local version of the model from the sharing service and then convert it to a multi-user
model.

The excluded model has no connection to the original shared model in the sharing service. This
means that if you exclude your local version of the model from the sharing service and start to use
the model in multi-user mode, you cannot later merge the original shared model and the multi-user
model.

For more information see TUA https://teklastructures.support.tekla.com/2021/en/ms_what_is_model_sharing
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2.6 Installing Tekla Structures Multi-user server
When more than one users are working on a project in the same location, you can use a Multi-User system
instead of Model Sharing. To enable this you need to install the multi-user server. The multi-user model consists of
a single master model. Each user can access this model and open a local view of the model. This local view is
called a working model. The image below shows one possible configuration of the Multi-User system.

Any changes a user makes to the working model are local and not visible to other users until the working model is
saved to the master model. The multi-user system can contain several client computers, where users work on
their working models. The master model can be located anywhere in the network, including any of the client
computers.

The multi-user server is a separate installation that is available on the Tekla Download site
https://download.tekla.com.

A Tekla Structures multi-user system runs on a TCP/IP network and consists of:

● Tekla Structures Multi-user server computer running xs_server.exe (started by AlwaysUp utility)
● A file server computer containing the master model
● Client computers running Tekla Structures

Operating system

Tekla Structures multi-user server 2.5.0 runs on the following operating systems (32-bit Windows is not
supported):

● 64-bit Windows 8.1
● 64-bit Windows 10
● 64-bit Windows Server 2016

Multi-user server hardware

The server that is used as the Tekla Structures multi-user server does not have to be very efficient or have
maximum performance. The multi-user server can be used in networks that use IPv4, IPv6, or both the IPv4 and
IPv6 protocols.
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Other infrastructure

Set up scheduled backups for the model data stored on your multi-user server and store the backups on a
different computer. The computers on the same multi-user network must have a unique IP address and identical
Subnet masks. The computer running the multi-user server should have a fixed IP address.

The Tekla Structures multi-user server runs as a service. This means that the Tekla Structures multi-user server
always starts automatically when you start the computer, and is always available when the computer is running.

For instructions on how to install the multi-user server and on how to run the multi-user server as a service see
TUA https://teklastructures.support.tekla.com/2021/en/sys_multiuser_multiuser_system

When more than one user is working in different locations, you should use Model Sharing instead of
multi-user.

3.    Customizing Tekla Structures

Tekla Structures administrator or BIM Manager is the person responsible for seeing that the company standards
are used and set up in Tekla Structures. The following sections explain how you can customize Tekla Structures.

Before you start customizing Tekla Structures to suit the needs of your company and your projects, collect the
needed information, such as drawing standards, used profiles, grades and materials, company logos, naming
conventions etc.

3.1 Tekla Structures Localization

Each new version of Tekla Structures introduces new features and functionalities to improve the overall process
used to complete a project. Tekla Structures has different environments to suit the needs and requirements of
specific markets. Many features are localized in each Tekla Structures version. Most of the changes in versions are
focused on making the default saved attributes more consistent, organized, simplified, and practical.

Your local technical team is dedicated to improving your knowledge and experience of each new version. The
team aims at enhancing your user experience of Tekla Structures by performing tasks that have been identified as
essential by existing users (through the Helpdesk), new users (through our training class) and potential users
(through demonstrations).

Lot of additional new content is also added to Tekla Warehouse https://warehouse.tekla.com like new application
tools and environment content. Tekla Warehouse Catalog Collections for each environment has all catalog
content; profiles, bolts, materials, reinforcements, etc. and you can search and install them inside Tekla Structures
Side Pain under Tekla Online > Tekla Warehouse.
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The overall localization / customization of Tekla Structures can be divided into four different layers:

● Tekla environment
● Company-level settings
● Project-level settings
● Multi-user settings

The three last ones are managed inside the company. Some companies also manage their own environment
settings.

Setting up the standards the company uses and the standards that a specific project needs will make the designing
process much more efficient as the end user can concentrate on the design process.

3.2    Overview of environments, roles and licenses
Tekla Structures is one product that has many different configurations. The licenses you have determine which
configurations you can use.

The environment is set up to use the material, grades, profiles, drawing settings, component settings, ini-settings
etc. that are used in a specific market. By choosing a specific environment when starting Tekla Structures you get
the settings for that market. When installing Tekla Structures you can select the environments you want to use,
environment can also be added later. There are 32 different environments in Tekla Structures. The blank project
listed in environments is an empty platform for one's own environment or project settings development. It
includes standard parametric profiles, undefined bolt, material and rebar grades, basic drawing layouts etc. which
you can complement from your own firm or project folders and Tekla Warehouse.
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The environments also give you the opportunity to choose a role when logging in. The role is independent from
the licenses that are used. The purpose of the roles is to make the user interface and settings clearer, easier and
faster for the type of work the user is performing.

In practice this means that settings, filters, reports and the user interface is set up for the role the user has. For
example, preloaded settings in a property dialog box not relevant for the role are not shown making the list of
options shorter and clearer.

Role selection is primarily meant to be configured by Tekla and reseller localization personnel, and be part
of Tekla Structures installation package. However, advanced users and Tekla Structures system
administrators can also create their own roles inside their company organization. Additional environment
offerings are available in Tekla Warehouse collections. Note that you need to have Trimble Identity for
downloading or installing from online collections.

See TUA https://teklastructures.support.tekla.com/not-version-specific/en/trimble_identity_faq

Installed folders

The software and environments are separated into different locations due to the requirements for Windows
certification. The default folder structure is:

● Software is installed under the .../Program Files/Tekla Structures folder.
● Environments and Extensions are installed under the .../ProgramData/Trimble/Tekla

Structures folder.
● User settings are in the .../Users/username/AppData/Local/Tekla Structures folder.

If you have an earlier version of Tekla Structures installed on your computer before installing version
2021, the installation will by default be done according to the old existing structure.
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Common environment settings

In the folder C:\ProgramData\Tekla Structures\<version>\Environments\ there is a folder named common. All
settings and files that are the same in all environments are located in this folder. Specific settings and files for an
environment are then located in a separate environment folder.

The env_global_default.ini file is also located in the common folder. This initialization file is the first one to
be read and it determines the standard settings. Other initialization files are read after this file and if the same
settings are made there, they will override the previous settings.

Environment folders

The country-specific settings are in the environments folder and they are localized by your local Trimble
office/reseller. The folder structure of the different environments can vary but the same kind of settings exist. The
settings that are localized are profile database, material database, reports, selection filters, view filters,
components and custom components, macros, user-defined attributes, drawings settings etc.

Tekla Structures 2021 version has a folder structure which is based on materials and roles in higher levels and
functional units in sub-folders. Common content to all roles is in the ”General” folder. For example the “General”
folder under Concrete is shared between Cast in place and Precast roles. Example from Default environment:
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Search order

When you open a model, Tekla Structures searches for the associated files in specific folders in a set order. It is
important that you locate files in the correct folders. Once Tekla Structures finds the associated files, it stops
searching. This means that files that have the same name but are located lower down the search order are
ignored.

The folder search order is:

Folder Defined by

Current model Open model

Project XS_PROJECT

Firm XS_FIRM
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System XS_SYSTEM

You can define more than one system folders. To do this, enter the file paths of the folders separated by
semicolons as the value for the advanced option (for example: set
XS_SYSTEM=%XSDATADIR%environments\uk\system_steel;%XSDATADIR%environments\uk\system_com
mon).

There are some exceptions from this search order. The exceptions are listed in TUA > Folder search order
https://teklastructures.support.tekla.com/2021/en/sys_folder_search_order

Do not store customized files in the search path of XS_SYSTEM. Tekla Structures replaces these files
when you install a new release.

3.3    Project and firm folders

Project and firm folders are for customized files. For any company we strongly recommend setting up firm and/or
project folders on a shared file server accessible to all users. Having the hierarchy of project and firm folders will
make updating company settings, seeing that everyone uses the same settings in a project, and upgrading to a
newer version of Tekla Structures much easier. When upgrading to a new Tekla Structures version, or updating the
company logo, for example, the files only need to be replaced in one place. This way taking backups and upgrading
is easier.

All the settings that are used on the company level (for example, company logo, drawing standards) should be
stored in a firm folder or its subfolders and all the settings used on a specific project should be stored in the
corresponding project folder. Property files are always saved first in the attributes folder under the current model
folder, for example, ..\TeklaStructuresModels\my_building\attributes. These files should then be
copied to the project or the firm folder.

To use the saved settings in a firm and a project folder, set the path to the folder by using the advanced options
XS_PROJECT and XS_FIRM. These advanced options should be put in the initialization files (see chapter 3.1.6). You
can have several different .ini files. You can define in the shortcut to Tekla Structures which .ini files to run and
which settings to apply.
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Tekla Structures does not replace files in the project and firm folders when you install a new release, so you retain
your customized files without having to cut and paste, or export and import from previous versions. This makes
upgrading to a newer version of Tekla Structures easier. By storing files in just one place it is also easier to update
the settings and see to it that everyone in a project is using the same settings.

Example:

In the current project, 123_project_ABC, you have set up the properties for the concrete column and saved them
as column_ABC. To make these saved settings available for everyone working in project 123_project_ABC, copy
the column_ABC.ccl from the attributes folder in the model folder to the project folder 123_project_ABC on
your file server. Make sure that everyone in the project has the correct path for their XS_PROJECT advanced
option in the .ini file.

For more information, see TUA > Project and Firm Folders
https://teklastructures.support.tekla.com/2021/en/sys_project_and_firm_folders. For information on
folders and file extensions, see TUA > Files and folders in Tekla Structures
https://teklastructures.support.tekla.com/2021/en/sys_files_and_folders

Project settings

Create your own component folder

Normally only a few different connections and components are used in a project. To make sure that everyone in
the project uses the same components and finds the components faster, we recommend you to create your own
component folder.

● Open the Applications and Components catalog from side pane on the right

● Create a new group for the project: right click > New group
● Add components to the group: select components > right click > Add to group, or drag and drop
● Hide not needed groups: right click > Hide
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The commands in Access advanced features  > Catalog management are used for modifying catalog
definitions. For more information, see TUA XS_COMPONENT_CATALOG_ALLOW_SYSTEM_EDIT.

For more information see  TUA
https://teklastructures.support.tekla.com/2021/en/det_getting_started_component_catalog

Project properties

At the beginning of a project you need to define project properties. This information is automatically used by
reports and drawings. You can also update the project properties during the project.

● Select File > Project Properties from the menu to open the Project Properties dialog box.
● Select Edit
● Fill in the project properties and click Apply.

Modifying reports and templates

You can modify existing reports and templates or create your own templates by using the Template Editor in Tekla
Structures. Go to File > Editors > Template Editor… , or double click an existing table in an open drawing to open
the tool.

For more information on the Template Editor see TUA
https://teklastructures.support.tekla.com/2021/en/rep_templates

Setting up the printers

Tekla Structures uses Windows drivers to write the print data directly to the Windows print device interface. You
can print drawings as PDF files, save them as plot files ( .plt ) for printing with printer/plotter, or print them on a
selected printer. To print to several paper sizes, you need to modify the drawingsizes.dat file. You can also change
the line width of the printed drawings. See more in TUA
https://teklastructures.support.tekla.com/2021/en/dra_print_printing_drawings
https://teklastructures.support.tekla.com/2021/en/dra_print_configuration_files
https://teklastructures.support.tekla.com/2021/en/dra_printing_to_pdf

You can affect the way Tekla Structures automatically names the .pdf files and plot files by using certain
drawing-type-specific advanced options. See TUA
https://teklastructures.support.tekla.com/2021/en/dra_customizing_pdf_file_names

3.4    Initialization files
Initialization files

Initialization files are used to launch Tekla Structures. They can contain many variables that you can use to
configure Tekla Structures for different standards and your own style of working. Tekla Structures automatically
creates the necessary initialization files during installation. The number of initialization files it creates depends on
how many country-specific environments you choose to install.

Why are .ini files needed?

There are numerous settings to be made when Tekla Structures starts. Advanced options are used to determine
the appearance and the behavior of Tekla Structures, for example, the language used, behavior of part marks on
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drawings, and the location of your model folder. The advanced options are set through the initialization files. The
different .ini files and what they do, and how they are related to each other are described below.

Different types of initialization files

The file teklastructures.ini in the bin folder starts Tekla Structures. We recommend that you do not make
any changes to this file.

env_<your_environment>.ini is located in the environments subfolder and it contains all the environment
specific settings. These files are set by your area office or reseller.

role_<role>.ini is located in the environments subfolder and it contains the specific settings for a chosen role.
For example the role_Engineer.ini in ../environments/uk/ folder contains all the settings for the
Engineering role for the UK environment.

lang_enu.ini is the initialization file for the settings for the English language and it is located with the other
installed languages in the ../nt/bin/ folder.

user.ini is the file where your personal settings are saved. The advanced options in user.ini override those in
other ini files. For example, if you have set the same advanced option in an .ini file, in a file in the environments
subfolder and the user.ini file, Tekla Structures uses the value in the user.ini file. The user.ini is located in the
C:\Users\<user_name>\AppData\Local\Tekla Structures\<version>\UserSettings folder.

Initialization file reading order

The default reading order for the initialization files is as shown in the image above:

1. teklastructures.ini

Initializes the settings needed for Tekla Structures to run.

2. env_global_default.ini

Sets the global default settings.

3. environment.ini

Sets the environment-specific settings.

4. role.ini

Sets the settings specified for the selected role.

5. user.ini
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Sets the settings specified by the user.

6. options.ini

Sets the settings specified for the company/project/model.

If there are settings for the same advanced option, the latter setting overrules the previous one. This means that
settings in user.ini overrule the settings in env_global_default.ini, which then can be overruled by options.ini.

We recommend that you make all your customizations in the options.ini (or user.ini) file. This way the
customizations are kept when you install the next version of Tekla Structures.

For useful information on the initialization files see TUA > Initialization files (.ini files)
https://teklastructures.support.tekla.com/2020/en/sys_initialization_files

3.5     Setting advanced options

About advanced options

Tekla Structures contains three kinds of advanced options, user-specific advanced options, system-specific
advanced options and model-specific advanced options.

Changing an advanced option value in the .ini files located outside the model folder does not affect
the existing models. You can only update advanced options in the Advanced Options dialog box or in
the options.ini file located in the model folder; not from an options.ini file located in folders defined
for the advanced options XS_FIRM or XS_PROJECT. The .ini files are read also when you open an
existing model, but only new advanced options that do not exist in options_model.db or
options_drawings.db are inserted, for example, such options that are not yet in the Advanced
Options dialog box but have been added in the software.

User-specific advanced options set your personal preferences, for example the appearance of the Tekla Structures
window. Tekla Structures saves user-specific advanced option settings in the options_<your_username>.ini file,
located in the C:\Users\<user_name>\AppData\Local\Tekla Structures\<version>\UserSettings
folder.

options.ini contains the settings for model-specific advanced options. It is located in the current model
folder. To share your settings with other people, copy options.ini to the system, project or firm folder.

The system-specific advanced options are stored in all other initialization files.

Setting advanced options

The .ini files are plain text files that can be edited with a text editor, such as Notepad. You can also use Tools >
Options > Advanced Options in Tekla Structures. The settings will then be saved in the options.ini in the model
folder for the model that you have open. The settings can then easily be copy-pasted into another .ini file. We
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recommend that you only use one of these methods to set advanced options. The settings in the Advanced
Options dialog box override those in the initialization files.

To set an advanced option in the user.ini file:

● Locate the advanced option in the C:\Users\<user_name>\AppData\Local\Tekla
Structures\<version>\UserSettings\user.ini file. Check that it is set and has the value
you want to use.

● If it has, you can stop here.
● To change or add the advanced option, continue to step 4.
● Right-click the user.ini file in Windows Explorer and click Open with... Select a standard text editor

from the list of available programs.
● On a new line, type set, then the name of the advanced option followed by its value in a single

line.
● Tekla Structures only reads lines in the initialization file that start with set, for example,

set %XS_DIR%=C:\TeklaStructures\2020
● Save the user.ini.

Some Advanced Options need Tekla Structures restart.

See TUA for more about Advanced Options
https://teklastructures.support.tekla.com/2021/en/sys_settings_databases
https://teklastructures.support.tekla.com/2021/en/sys_app_environment_variables

3.6   Creating shortcuts
To use the correct .ini files for a specific project the easiest way is to create a shortcut for the project on the
desktop. Shortcuts are used to start teklastructures.exe with defined initializations.

To create a project-specific shortcut:

1. Make a copy of the default shortcut. In the Windows Start menu, go to All Programs > Tekla Structures
<version> > Tekla Structures <version> and right-click.

2. Select Copy from the pop-up menu.

3. Paste the shortcut to your desktop.

4. Select the shortcut and right-click.

5. Select Properties... from the pop-up menu.

6. Modify the Target of the shortcut by adding the required project initializations to it.
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You can use the following parameters in shortcuts:

● -i InitializationFile: Initialization file to be read during startup, for example: -i
\\MyServer\MyProject\Project1.ini. You can repeat this parameter as many times as you need.

● ModelToBeOpened: Full path to the model to be opened automatically.

Ini files tell where things can be found and in which order, depending on the folder structure that the company
has set up.

For more information on the topic, see TUA
https://teklastructures.support.tekla.com/2021/en/sys_creating_shortcuts_for_customized_initializations

3.7   Bypassing login screen
If you want to bypass the login dialog box, use a separate .ini file, where you set the following three new advanced
options:

● XS_DEFAULT_LICENSE The advanced option has the following options:
○ CARBON
○ GRAPHITE
○ DIAMOND
○ EDUCATIONAL
○ DEVELOPER
○ EPM_MODELER

● XS_DEFAULT_ENVIRONMENT This advanced option points to the environment specific .ini file, for
example %XSDATADIR%\environments\uk\env_UK.ini
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● XS_DEFAULT_ROLE This advanced option points to the role specific .ini file, for example
%XSDATADIR%\environments\uk\Role_Steel_Detailing.ini

To be able to set these advanced options, you can use the new parameter for the shortcut: -I (capital i). This points
to an additional initialization file to be read BEFORE reading the environment ini. For example.: -I
%XSDATADIR%\environments\uk\Bypass.ini

Example content of such an .ini file:

set XS_DEFAULT_LICENSE=DIAMOND
set XS_DEFAULT_ENVIRONMENT=%XSDATADIR%\environments\uk\env_UK.ini
set XS_DEFAULT_ROLE=%XSDATADIR%\environments\usa\role_Steel_Detailer.ini

3.8    User-defined attributes
User-defined attributes are attributes set to an object in a model or a drawing. These user-defined attributes can
be used for many purposes; they can be used in filters, drawings, reports, export, import, fabrication, erection,
revision handling, etc.

You can create your own user-defined attributes that you need in your company or for a specific project. The
user-defined attributes can be numbers, text, lists, or dates. They can be set to be unique for an object or allowed
to be copied; they can also be ignored by numbering or affect numbering.

The user-defined attributes are defined by objects.inp files. These files are located in different folders
(following the Tekla Structure folder setup) and they are merged together during startup. The objects.inp file
reads attributes in order from the folders listed in the table below starting with the model folder:

Folder defined by advanced option

Model (current model folder)
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Project XS_PROJECT (your defined project folder)
Firm XS_FIRM (your defined firm folder)
System XS_SYSTEM (your defined …)
inp XS_INP (your defined …)

The files are merged so that if there are user-defined attributes in any of the files, they are displayed in the user
interface. Tekla Structures merges the files in a way that eliminates duplicate attributes. If Tekla Structures
encounters the same attribute name in different objects.inp files, the attribute from the first read
objects.inp file will be used.

You can additionally use file naming objects_<suffix>.inp and they are merged to objects.inp files. Example:
objects_precast.inp. This enables having several objects_<suffix>.inp files in the same folder.

For more information about adding your own UDAs, see the TUA
https://teklastructures.support.tekla.com/2021/en/sys_example_creating_and_updating_uda

3.9   Model templates

You can save the desired settings in a model and use that model as a template when you create new models. This
can be very useful if your company has projects of different kinds; parking garages, office buildings, bridges,
industrial. These model templates can then be accessed when creating a new model.

When you create a model template, always start by creating a new empty model. This is because old models
cannot be completely cleaned and they might contain quite a lot of information even if you delete all objects from
the model.
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To create a model template:

1. Create a new model and give it a unique name. For example, Steel framework.
2. Add the desired profiles, custom components, and so on, in the model.
3. Save and close the model.
4. Move the whole model folder in the location pointed by the advanced option

XS_MODEL_TEMPLATE_DIRECTORY. By default, the advanced option points to the folder
..\TeklaStructures\<version>\environments\usa\Imperial\General\ModelTemplates\

5. In the new template model folder, open the TeklaStructuresModel.xml file using any standard text
editor.

6. Set the <IsTemplate> element to TRUE. The default value is FALSE.
7. Save the file.

You can also obtain model templates from Tekla Warehouse https://warehouse.tekla.com by typing “model” into
the search field. Example of Start model offshore:

“Insert into model” button installs the model template directly under XS_MODEL_TEMPLATE_DIRECTORY location
and it is instantly selectable in new model creation.

It is strongly recommended to update your model templates in Tekla Structures version upgrade. See
instructions in TUA
https://teklastructures.support.tekla.com/en/support-articles/version-update-model-templates
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3.10    Customizing reports and drawings

If your company already has graphical templates in DXF, DWG, or DGN format, you can convert these into Tekla
Structures templates. For detailed instructions on how to do this see Template Editor Help > AutoCAD and
Microstation files.

The Template Editor Help also gives instructions on how to create your own templates and reports. Additional info
is also available in TUA https://teklastructures.support.tekla.com/2021/en/rep_reports and
https://teklastructures.support.tekla.com/2021/en/rep_templates

3.11    Cloning templates drawings

You should consider cloning drawings when:

● There are several similar parts, assemblies, or cast units in the model.
● You need to produce single-part, assembly, or cast-unit drawings of similar parts, assemblies, or cast units.
● The drawings need a lot of manual editing.

For example, you can create a drawing for one truss, edit the drawing, and then clone it for similar trusses. Then
you only need to modify the cloned drawings where the trusses differ.

The cloned drawing may contain more parts than the original drawing. Part properties, marks, associative notes
and related text objects are cloned from a similar part in the original drawing.

Cloning template drawings

With the Master Drawing Catalog you can use a drawing as a cloning template. When a drawing is set as a cloning
template in the Master Drawing Catalog it can also be used in other models. This can be used in projects that have
the same kind of drawings.

To create cloning templates:

● Select a drawing from the Drawing List.
● Right-click and select Add to Master Drawing Catalog and then fill in the required properties.

The cloning template can be found under Cloning templates in the Master Drawing Catalog. The cloning templates
can also be used in other models. To do this, open the Master Drawing Catalog in the model, click on the Select
models where Cloning templates are collected -icon and add the model where the templates are saved.

For more information on the Master Drawing Catalog and cloning templates see TUA
https://teklastructures.support.tekla.com/2021/en/dra_creating_drawings_in_master_drawing_catalog

4. Where to find more information?
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Tekla Structures User Assistance (TUA)
Tekla Structures User Assistance contains information on how Tekla Structures works and instructions for using
and setting up the program. We recommend you to always check the TUA first – that will save you a lot of time.

Release Notes and Administrator’s Release Notes
In Administrator’s Release Notes that are published with each version of Tekla Structures there is a lot of
information about how to customize and take the newest features in Tekla Structures into use. Release Notes
describes what is new in each release of Tekla Structures. By reading the Release Notes you can make sure that
you are on the leading edge. Both are available in TUA.

Tekla Discussion Forum
Tekla Structures discussion forum is a useful way to share experiences, ask questions, and take part in advanced
user’s knowledge. You need a Trimble Identity to login. See more in https://forum.tekla.com

Tekla Developer Center
Tekla Developer Center is the central information source for Tekla Open API developers. Visit the service at
https://developer.tekla.com for API reference, programming guides, exercises, code examples, a community for
asking questions and sharing best practices, and more.

Attend training
To use Tekla Structures to its full potential we strongly recommend users to attend training courses held by your
local Trimble Solutions office/reseller.

Your local help desk
If you are on maintenance, you can e-mail or phone your local help desk for help.

You can also use the Support Tool inside Tekla Structures. On the File menu, click Help > Contact Tekla support
and log in using your Trimble Identity. See more in
https://teklastructures.support.tekla.com/2021/en/int_contact_support
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